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Introduction 

Florida Department of Transportation (FDOT) Electronic Field Book system (EFB) is designed to 
meet the specialized operational requirements for highway route surveying. The desktop 
version of this system is designed to allow the user broader access to data in an office 
environment, providing a larger viewing area with a quick overview style interface, thereby 
allowing access to more data at one time than is possible with the handheld device. 

The computer platform for office operations is a desktop or notebook PC, operating under 
Windows. Files may be transferred to any other operating system as desired. 

This documentation is intended to specifically describe the operation of the Electronic Field Book 
system within a windows-based pc environment for office operations. The documentation serves 
as a supplement to the documentation provided for the EFB handheld device. For more detailed 
information, regarding the technical operations of the EFB system, please refer to the EFB 
Mobile documentation. 

The American Association of State Highway Transportation Officials (AASHTO) Survey Data 
Management System (SDMS) Processor module is incorporated as an add-on module to the EFB 
Desktop. Please refer to its in-application documentation which can be accessed from the 
Windows Start button, and selecting "FDOT SDMS Processor" from the All Programs listing. This 
will bring up not only the specially compiled version of the AASHTO SDMS application for FDOT, 
but will provide links to the various SDMS Processor documents. 

Note: Processing the data collected is explained in separate publications.
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Application Overview 

EFB Desktop program opens with the llfollowing ldialog box 
offering the user two choices: open an existing project or 
create a new project. A project file contains a unit of survey 
field data that may be processed into coordinates, and was 
formerly called a "Segment" in the previous DOS version of 
EFB. EFB Survey data is stored in a database format with an 
.SDF file extension.

The dialog box has three tabs. The (D) Data and (C) CTL 
tabs functionality will be disabled until an action has been 
taken in the (F) File tab. Selecting the (D) Data or (C) CTL 
tab first will open a dialog message guiding the user back 
to the (F) File tab selections.

The (F) File tab has three options: (N) File New, (O) Open or (S) Save As, as illustrated above.

The (C) CTL tab also has three options: (H) Control File Header, (P) Control Points or (A) Add 
New Control Point, which are shown disabled above.

The (D) Data tab is the Switchboard of the EFB Mobile 
device commands, a view of the switchboard is below:
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Note: To return to the start up dialog box (Switchboard, Control Points or File menu), 
type the Enter key when the cursor is in the MSG> box.

Below is a sample screen of the EFB Desktop program with a Project loaded. Note the locations 
of the Main Menu, Field View pane, Tree View pane, Drop-Down toolbar, Data View tabs and 
the Data View pane. This section will provide a general overview of the functionality of each of 
these components. 

Upon startup of the EFB Desktop program a Startup Log is created. The log will provide system 
information about the Name and Location of the EFB Desktop executable, Port names and the 
operating system parameters of the computer that is being used. 

The Windows 7 default location for the Startup_Log.xml file would be 
C:\Users\username\Documents\EFB folder, where username equals the user login of the 
computer being used to run EFB desktop. An environment variable is used to locate the user 
folder. This file may be viewed using a text editor such as NotePad. This log file helps the 
programmers determine startup errors, and may need to be shared with the Department when 
debugging startup errors, should that occur. 

Manual EFB Desktop Application Overview • 3 



Main Menu 

File Menu 

The EFB Desktop File Menu provides ll all of the same lfunctionality that exists in the EFB
ilMobile File 

Menu. The EFB data is now stored in a database. A database lfile is either created upon startup
or an existing database is opened. The llfollowing operations may be executed to lmanipulate the  
database file. Records within the datab ase file (project file) will continue to be Recorded (0), 
Modified (6) or Deleted (3), using the same method as the Mobile device. The illustration below 
displays the layout of the EFB Desktop File Menu.

Detailed explanation of each of the File commands:

New: Opens the Save As SDF... dialog box, prompting the user to create a new project 
name and location.

Open: Opens the Open SDF File... dialog box, prompting the user to open an 
existing SDF project.

Save As: Opens the Save As SDF... dialog box prompting the user to create a new project 
name and location. It is used to create the filename and storage location in the Windows 
folder system for the segment of survey data being surveyed. This command would be 
used when a new project is based off of data from an existing project.

Import: Allows the user to import existing segment data (OBS & LandXML), Control Points 
(CTL or XYZ) to be used with the segment being surveyed. It also allows for Validating 
LandXML 1.2 Files from other applications. 
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The segment file may be imported as either:

OBS – Observations & Chains:  With .OBS file extension (from the classical EFB). It 
contains established Observations and Chains. An OBS_Chain_Import_Errors.log is 
generated and stored in the same folder as the OBS file. It will automatically display 
when there are mismatches between the Shorthand and Expanded Chain lists coming 
from the imported .OBS file. It is up to the user to correct any discrepancies.

Sample Log file: 

CTL - Control Points: With .CTL file extension, it contains established Control 
Points (.CTL is the same as the classical EFB).

XYZ – Points: With .XYZ file extension, it contains coordinate values of Control 

Points (.XYZ is the same as the classical EFB).

LandXML: With .XML file exten sion, it contains all information (observations, chains 
and/or control points) that make up a segment. These LandXML files provide portability 
to other applications.

NOTE: Importing data will replace any existing data in the current segment. 

Validating LandXML 1.2 File: This command will open the ESCO - LandXML File 
Validator 1.2 dialog box as illustrated below:

In the dialog box, click the Browse button to locate the LandXML file for validation, and
then click the Validate File button to process. The results will be displayed in the  
Validation Results table Line #, Position # and the Error Message will be listed.

Merge: Allows the user to merge existing Control Points (CTL or XYZ) to be used with the 
segment being surveyed. This differs from i mport; instead of creating an entire new file, 
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only the new information is brought into the current file. The routine compares the existing 
data with the merged data and for any new point it will merge all of the information 
associated with that point. For points that are the same name, the only data that will be merged 
are blank fields in the existing file. The existing information takes precedence. 

Export: Allows the user to export the current data to OBS, LandXML Control Points (CTL or 
XYZ) files or Convert EFB LandXMLdata to CAiCE SRV and KCP (CAiCE Survey and CAiCE 
Project) / GEOPAK INP (Input file) formats. 

The segment file may be exported as either: 

Observations & Chains As OBS...: With .OBS file extension, it contains 
established Observations and Chains.

Control Points As CTL...: With .CTL file extension, it contains established Control Points.

Points As XYZ...: With .XYZ lfile extension, it contains coordinate values of 
Control Points.

LandXML... With .XML file extension, it contains all information (observations, chains 
and/or control points) that make up a segment. These LandXML files provide portability 
to other applications.

Each Export type will create a temp.job file within the same folder name embedded as 
the type file being exported; this file will contain the filename of the file being 
exported, and is used by the processor. 

In addition, the .CTL export will copy the .CTL file to a new file with a .CCC file extension 
into the same folder, in case the SDMS version of the processor is used. 

Convert EFB LandXML to SRV, KCP, INP : This utility is used to convert data from a 
LandXML file to CAiCE SRV, CAiCE KCP, GEOPAK INP and LandXML Grouped Output.
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Convert CAiCE table to SDMSFEAT INI : Converts CAiCE feature table symbology table 
(.tbl) to SDMS Processor .ini format. This utility is available so non -FDOT standards can 
display in the SDMS processor for graphical network, point and chain review.

LandXML Grouper Utility: This utility adds point and chain groups into LandXML data by 
defining point or chain groups using filters for name, feature code, description, attribute 
and zone. Users can additionally refine groups by adding/removing individual points or 
chains.

Manual EFB Desktop Application Overview • 7 



feature makes the input mode feature driven . This feature is “On” or checked by 

feature is “Off” or NOT checked by default. The log is useful for troubleshooting polling

Seed New Segment: Allows the user to seed a new project segment with an existing 
project’s existing points and chain information. The New Segment file will start 
Point Name numbering where the previous file left off. 

Use CEFB Input Mode: When checked, the CEFB (C representing Cadastral) Input Mode

default. See Feature Code section for more information.

Generate Polling Log: When checked, the Generate Polling Log feature creates a log to capture 
the sequence of events while polling for instrument measurement information . This

errors. Unlike the StartupLog, which writes to an XML file, the Polling Log writes 
to the internal .SDF database only. 

EFB Processor (EFBP): Opens a dialog box used to initiate point data reduction and 
coordinate processing on the collected field survey data. The process reduces raw 
measurements to angles and distances used to create coordinates and/or elevations for all 
of the observed/measured points. The processor also generates reports for viewing 
and/or printing. Processing is performed using EFBP.exe program written by D. Ray Hintz. 
(See the Point Processing section for more information and detailed instructions.)

SDMS Processor: Launches the public domain version of the AASHTO SDMS Processor. The 
SDMS Processor is a complement to the SDMS field data collection system which provides 
processing and analysis of survey information into coordinates for import to standard office 
survey and engineering software systems. The SDMS Processor also uses a slightly 
different version of Dr. Hintz's EFBP.exe , that looks for .CCC control files instead of .CTL 
control files. The SDMS processor provides graphical viewing of survey data, and a rich 
compliment of COGO and other functionality. 

When files are exporting for SDMS processing, each Export type will create a temp.job file 
within the same folder as the type file being exported. This file will contain the filename 
of the file being exported.

In addition, the .CTL export will copy the .CTL file to a new file with a .CCC file 
extension into the same folder, so the SDMS version of EFBP.exe can execute. 

Exit: Closes the program.
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Edit Menu

The Edit Menu of EFB Desktop provides the functionality 
to Un-Delete records with the following criteria: 

• Must be an Observation (HVD or SOR) and 
• The highlighted record (reading) in the data grid 

must be a previously deleted record. 

Control Points Menu

The Control Points Menu provides a method of managing 
Control Points in the segment. This is done by establishing the 
Control Point Settings for the project, adding a point or 
removing existing control points for an EFB file. 

Help Menu 

The Help Menu provides access to the documentation for both EFB Desktop and EFB Mobile. 
Documentation for each platform supported by EFB is provided in two forms: Contents and PDF 
Manual. The PDF Manual provides a format for printing out the selected help manual. Contents 
opens up a hierarchical set of help files (standard compiled CHM file) for either EFB Desktop or 
EFB Mobile. 

About EFB Desktop displays the EFB Desktop version information.
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Field View 
The Field View pane provides the same lfunctionality as 
the
interface of EFB Mobile and matches the lmobile unit screen 
in appearance. Data can be created and modified using ll all of 
the same command and navigation keystrokes used by EFB 
Mobile. For full documentation regarding the available keystrokes, 
please consult the EFB Mobile documentation. 

As with EFB Mobile, the Field View message bar (MSG>) 
requires focus to accept command and navigation 
keystrokes. When the message bar has focus, a blinking 
cursor is visible in the field. 

When saves (record “0”), modifications (modify “6”) and 
deletes (delete “3”) occur in the Field View, the 
rest of the Desktop interface is updated to reflect 
the change. 

The Tree View pane allows the user to clearly 
see the hierarchical organization of data records, 
allowing for easier and faster access to 
information. With this feature, the user is 
provided with the ability to easily browse 
through all of the EFB data that has been 
collected without having to Page Back/Forward 
through each individual screen in the Field View 
pane, as is required on the EFB Mobile device. 

When the user selects an item in the Tree View 
pane, the Field View and Data View panes are updated 
to reflect the item selected. 

When a new item is added in the Field View pane, 
the Tree View pane is also automatically updated 
to reflect the change. 
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Data View 
Within the Data View, all information is read only. The data is shown in raw format and needs 
to be viewed in the Field View to be seen as formatted. When an item is selected, the related 
information is displayed in the first tab (for example, Observation Info.) If any child 
relationships exist, additional tabs are added with data-grids that contain the child records. 

For example, if the Segment Header is selected, the Remarks tab displays any remarks records 
associated with the Segment Header. 

The Tree View, Data View, Field View and Drop-down Toolbar are always kept in sync. If the 
user switches tabs, the Field View is updated to show the c ontrols used to enter the relevant 
data. 
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ta type

Drop-down Toolbar 
The Drop-down Toolbar contains up to four drop -down lists depending on the current page that 
has been selected. Below are examples of drop -down lists that are available for each da 
handled in the interface. When a new item is selected in the interface, the Drop-down 
Toolbar updates to reflect the list of data that is available to select from.

• When the Switchboard page is selected, there are no Drop-down Toolbar lists 
available and the Drop-down Toolbar area is blank.

• When the Segment Header page is selected, four drop -down lists are available:
• Calibrations, Setup, Observations, and Chains.

• When the Control Points page is selected, only the Control Point list is available.

Note: The drop-down lists a re independent of each other and contain all of the items 
available for each of t heir data type and are not filtered based on 
selections made in the other dro p-down lists.
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Getting Started 

Setup/File Structure 
The EFB Desktop install will create the following folder structure in the applicable Program File 
folder. 

An EFB folder is also created in the users Documents folder. A variable within the program will 
locate the Users folder, accommodating various Windows operating systems. A log file named 
Startup_Log.xml will be created and saved to the users EFB folder. 

Example folder path: C:\Users\Username\Documents\EFB

Startup Routine 
Upon initial startup of EFB Desktop executable the program creates a working directory in the 
users Document folder. An example folder path would be: C:\Users\lmattor\Documents\EFB.
Within this folder an XML file is generated called Startup_Log.xml. All subsequent uses of the 
EFB Desktop program write to the Startup_Log.xml with the EFB Desktop system information. 
The file is written over each time the program is loaded. 
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Open an Existing File 
While it is possible to create an OBS or LandXML file from scratch within EFB Desktop, it is 
much more common that these files will be created on a handheld device using EFB Mobile and 
then later transferred to a desktop computer running EFB Desktop. One of the methods for 
transferring files from Mobile devices running Windows Mobile or Windows CE is to use 
ActiveSync, a free program from Microsoft that is used to transfer files between desktop 
computers and Mobile devices. 

Once the files are located on the Windows Desktop computer, the user can open them from EFB 
Desktop using the File Menu. Simply select the Open command, select the applicable project file 
(.sdf) and the data will be read into EFB Desktop. The interface will be updated to reflect the 
new data that has been loaded in. 

Data Management 
With EFB Desktop a user can view, modify, and create data. The Field View pane can be used in 
the exact same way that EFB Mobile is used. The pane needs to have focus to accept the 
available command and navigation keystrokes. To make sure that the Field View has focus, click 
inside the Message Bar area and a blinking cursor should appear within the field to indicate that 
focus is set. 

The other EFB Desktop interface components can also be used to navigate and view data, but 
none of the other components can be used to create or modify data. All data creation and 
modification is done using the Field View pane only, in the same way that EFB Mobile does. 

To navigate to a specific segment (observations and chains) or a control point, use the Tree 
View to expand or collapse views. 

Saving Data 
Saving data to the EFB database is conducted in the same method as with the handheld units. 
The program forces the user to create an SDF file, or open an existing SDF file prior to enabling 
any other commands. 

Listed below are the commands available to manipulate data in the EFB database. 
• 0 for Record (Place the cursor in the MSG> box and the type “0” (zero)). The 

word “Saved” will appear in the MSG> box.
• 3 for Delete (Place the cursor in the MSG> box and the type “3” (three)). A message 

box will appear asking “Are you sure you want to Delete, Yes/No?”
• 6 for Modify (Place the cursor in the MSG> box and the type “6” (six)). A message 

box will appear asking “Are you sure you want to Modify, Yes/No?”

An alternative option which allows a user to maintain the integrity of the original file is the 
command File > Save As. This allows a user to save the newly altered file as a new file apart 
from the original. 
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Feature Codes 

Overview 
Feature Codes can be setup in advance for the default values of the point and chain attributes. 
The default values associated with the following screens: Setup, HVD-Obs, SOR-Obs, Chains, 
and Taping along with being integrated into the Control Point menu. The following attributes 
may be preset: Point Geometry, Units, Alias, Prompt, DTM Attribute, Zone, Chain name prefix & 
Point name Prefix.

Feature code “builder” will assist the user in the creation of the descriptor of the feature code 
by utilizing a builder_template command in the EFB_Settings.xml file. This functionality will 
provide a more efficient method of data entry and result in standardized naming and attribution 
conventions.

The Administrator of the EFB software will predefine the default values for the point attributes 
and nomenclature for any given feature code by editing the EFB_Settings.xml file. 

Administration 
The EFB_Settings.xml file will be located in the same folder as the EFB executable file (typically 
an EFB folder under Program Files). Use any text editor, such as Notepad, to modify this file. 

RECOMMENDATION: Archive existing copy prior to any changes!

Scroll down the file until you find the <FeatureCodes> section, this is where all feature code 
definitions will be defined. Default values would be placed within the double quotes “” following 
the field name (attribute) being edited. 

The Feature Code Builder can either automatically fill in a standard descriptor, prompt the user 
to enter a value, or provide the user with a drop down list of values to select from. All feature 
code parameters are separated with a white space and all parameters are to be assigned within 
the double quote “”, after builder_template. 

The following syntax is required for the “builder_template” command to function properly: 

Lists: [item1 item2] Items within square brackets, space delimited, lists down from left to 
right.

EX: [Radio TV Tower Cellular] would read: Radio 

TV 

Tower  

Cellular 

Prompt: &lt;prompt&gt;

XML restricts the use of less than “<” or greater than “>” signs, which necessitates the 
use of the Escape code keys (“&lt;” for less than and “&gt;” for greater than). 
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• Click the button to the right of the 
Feature Code field. This will display a list of 
applicable feature codes for the feature type 
(point or chain). 

• <OR> with the cursor in the MSG> box, type 
the key Q to initiate the Feature Code Builder.

EX: &lt;Diameter?&gt; would read: Diameter? 

The value would be keyed in to the open text box in the Feature Code Builder dialog box 

by the user. 

Standard descriptor (literal value): is entered with no other characters at the 
beginning or end of the value.

EX: “Antenna” will be placed in the location of the descriptor based on where it is 
located in the builder_template. For example, if it should appear as the first 
part of the descriptor, it needs to be placed at the beginning of the command 
line for builder_template .

Next: ~ (tilde) is placed after a prompt value and before the &gt; closure.

User 
Feature Code Builder is a function available in the following screens: Setup, HVD -Obs, SOR - 
Obs, Chains, and Taping along with being integrated into the Control Point menu.

Feature Code Builder initiation is as follows:

EFB Input Mode (Data input type in the File Menu, 
where Use CEFB Input Mode is NOT checked): 

Typically in this scenario, a Point or Chain prefix 
would be entered into the N: text box.
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• <OR> Click the button to the right of 
the Feature Code field. This will display a list 
of applicable feature codes for the feature 
type (point or chain) desired.

• <OR> With the cursor in the MSG> box, type 
the key Q to initiate Feature Code Builder. 

button. 

CEFB Input Mode (Data input type in the File Menu, where Use CEFB Input Mode IS  checked):

Typically in this scenario, the Point or Chain Prefix is 
determined by the Feature Code being used, 
although it is not required as flexibility is built into 
the program. 

• In the Feature Code (F:) field, type a known 
feature code (EX: ANT) followed by a dash “ 
- “. Once the dash is keyed, the Feature Code 
Builder will initiate. 

Based on your selection the Feature Code Builder will 
prompt for the proper settings of the particular feature 
selected. 

EXAMPLE: 

1. Select the applicable feature code from the Feature Code Builder list: 

2. Use the up and down arrows or the mouse and cursor to highlight the required feature 

code, then click the

Note: Only feature codes that pertain to the geometry type (Point or Chai n) 
will be presented in this list.
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3. Upon selecting the feature code for Antenna “ANT”, the following dialog box will 
appear: 

4. Use the up and down arrows or the mouse and cursor to highlight the applicable item 

and then click the button to accept the selection and to open the next dialog 
box. 

5. Click the button to accept the selection and to open the next dialog box, in 
this example all the information required was entered and the builder goes back to the 
original screen. This will build a Feature-description string of "ANT-RESIDENTAL RADIO 
ANTENNA". Note that this builder can also embed the literal terms like "ANTENNA" in the 
description strings it build. This function will help standardize descriptions of objects 
observed in the field. 

Note: This example is in the EFB Input Mode.
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6. When in the CEFB Input Mode and changes have been made to the Feature Code, point 
prefix or any of the parameters (Point Geometry, DTM Attribute, Zone, and Chain 
Name), the Attribute Update Prompt dialog box will display prior to returning to the 
original screen. 

7. Select the applicable action to be performed and then click the OK button to return to 
the original screen. (See the Attribute Update Prompt section below for further 
explanation of its functions.)

8. When the feature code-description string exceeds the 18 character space limitation of 
the .OBS / .CTL formats, the feature code descriptor will automatically be placed in the 
Comments screen. Click the C: button to call up the Comments screen: 
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Program Logic – Point and Feature Code Entries 
When a point is saved: (EFB or CEFB input mode) 

1. The feature code field is checked to see if a value was entered. 

2. If a value was entered, the feature code to prefix relationship is added to the internal 
FeatureDefaultsListFeature Defaults List table in the database along with a time stamp.

3. If no value was entered, then it is ignored and the relationship to the other attributes is 
ignored as well. 

When a point is entered: (EFB or CEFB input mode) 

1. The Feature Defaults List is searched for the most recent use of the point prefix. 

2. If not found, the Setting XML feature codes are searched for a point prefix match. 

3. If not found, the defaults of Point geomerty, Ground attribute, and Zone 1 are 

used. When a feature is entered: (CEFB input mode only)

1. The Feature Defaults List is searched for a feature match. 

2. If not found, the Setting XML, feature codes are searched for an alias match. 

3. If not found, the Settings XML feature codes are searched for a feature match. 

4. If not found, the defaults P G 1 are used. 
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Attribute Update Prompt (CEFB Input Mode only): 
When in the CEFB Input Mode, the user has options available on how the feature code naming 
and data will be stored. The Attribute Update Prompt dialog box will appear when a different 
value is entered into any of the following fields: Feature code, Point Geometry, DTM Attribute, 
Zone, or Chain Name. The Attribute Update Prompt dialog box will prompt the user to choose 
whether to overwrite any part of, or all of the previously entered information for that object. 

Name refers to Point Prefix (N:) and parameters refer to Point Geometry, DTM Attribute, Zone, 
and Chain Name. 

The first time a feature code is used, the program will use the Settings XML values for the 
Point prefix and the parameters for Point Geometry, Units, Alias, Prompt, DTM Attribute, Zone, 
and Chain Name. 

A Feature Code default table is generated with each new SDF file (project file). As feature 
codes are entered and saved, the Point name and the parameters are stored in this table. 

K: Keep name prefix & parameters: This selection maintains the values that were entered 
in the previous dialog box (Setup, HVD-Obs, SOR-Obs, Chains or Taping). The point prefix 
or any of the parameters listed above WILL NOT be overwritten. This is the default action.

B: Update name prefix & parameters: This selection changes the values that were entered 
in the previous dialog box (Setup, HVD-Obs, SOR-Obs, Chains or Taping). The point prefix 
or any of the parameters listed above WILL be overwritten by the new values entered. The 
program compares the values to the Feature Code defaults table. If the Feature code is 
found, it uses the Point prefix and parameter values in the table to overwrite the values 
entered in the previous dialog box.

If the Feature code is not yet in the table, the program uses the Feature code Point prefix 
and parameter values from the EFB_Settings.xml to overwrite the values entered in the 
previous dialog box. When the record (a new point) is saved to the EFB database, it will 
also write the new Feature code point prefix and parameters to the Feature Code defaults 
table. The next time that same feature code is used, it uses the values from this table, if B: 
Update name prefix and parameters is selected. If different values are required, the 
changes will need to be made in the Observation (or chains or taping) dialog box. 

P: Update name prefix only: This selection changes the Point prefix value that was entered 
in the previous dialog box (Setup, HVD-Obs, SOR-Obs, Chains or Taping). The point prefix 
WILL be overwritten. The program compares the value to the Feature Code defaults table. 
If the feature code is found it uses the Point prefix value in the table to overwrite the value 
entered in the previous dialog box.
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If the Feature code is not yet in the table, the program uses the Feature code Point prefix 
value from the EFB_Settings.xml to overwrite the value entered in the previous dialog box. 
When the record (a new point) is saved to the EFB database, it will also write the new 
Feature code Point prefix to the Feature Code default table. The next time that same feature 
code is used, it will use the values from this table, if P: Update name prefix only is selected. 
If different values are required, the changes will need to be made in the HVD-Obs, SOR-Obs, 
Chains or Taping dialog box. 

A: Update parameters only: This selection changes the parameter values that were entered 
in the previous dialog box (Setup, HVD-Obs, SOR-Obs, Chains or Taping). The parameter 
values WILL be overwritten. The program compares the parameter values to the Feature 
Code defaults table. If the feature code is found it uses the parameter values in the table to 
overwrite the values entered in the previous dialog box.

If the Feature code is not yet in the table, the program uses the feature code parameter 
values from the EFB_Settings.xml to overwrite the values entered in the previous dialog 
box. When the record (a new point) is saved to the EFB database, it will also write the new 
Feature code parameter values to the Feature Code defaults table. The next time that same 
feature code is used, it will use the values from this table, if A: Update Parameters Only is 
selected. If different values are required, the changes will need to be made in the HVD-Obs, 
SOR-Obs, Chains or Taping dialog box. 

In a saved point record, if a new feature code is entered and K:
Keep name prefix & parameters is selected, a point is modified 
and will need to type 6 to modify & save. If B: Update name 

Hint prefix & parameters is selected, then a new point is created 
and you will need to type 0 to save.

Note: In all cases, if the Feature Code does not exist in the EFB_Settings.xml an error 
message will appear in the MSG> text box. EX: Bad Feature Code.
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Viewing and Modifying Data 

Switchboard 
When the Switchboard page is selected, the Data 
View is empty, there are no lists available in the 
Drop-down Toolbar, and the Switchboard screen 
is shown in the Field View. 

Segment 
When the Segment page is selected, the Data 
View displays the information about the current Segment (including any associated Remarks), 
and four (4) drop-down lists are available to select from in the Drop-down Toolbar: 
Calibrations, Setups, Observations, and Chains. These are all of the items contained within 
the current segment. 
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Segment Observations 
When one of the Observations pages is selected (Calibrations, Setups, and Observations), the 
corresponding Data View is displayed and three (3) drop-down lists are available to select from: 
Calibrations, Setups, and Observations. 

Segment Chains 
When one of the Chain pages is selected, then the Chains information is displayed in the Data 
View and one list is displayed in the drop-down Toolbar: Chains. 
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If any of the existing
Control Points are selected, 
the information displayed 
is specific to the selected 
Control Point. One drop-
down is displayed: Control 
Points.

Control Points 

A project with no Control Points lestablished ll will ldisplay an empty lfile with a project 
name of
“Untitled”. Startup of a Control Point setup can be accomplished by either selecting the 
Control Point Settings command in the Control Points Menu or by selecting the Points branch in the 
Tree View. The initial setup of the Control Point file will require naming of (or referring to) 
the EFB project and setting the Units, State Plane Code, NAD (Horizontal datum) and NGVD 
(vertical datum). These settings will apply t o all Control Points added to a project. 

A control file may be imported into the file by selecting File > Import from the Main Menu or new 
points added individually by selecting the Add Point command in the Control Points Menu. At any 
time after points have been added, the user also has the option of Merging in Control Points 
from a Control Point (.CTL) file. (See the File Menu section of this document for further 
explanation of the differences between importing and merging).
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Control Point Settings 
Master Control Point settings are established by selecting 
Control Points > Control Point Settings from the Main Menu. 
The following screen will appear:

Enter in the Project Name along with the applicable 
settings for that project. Once these settings have been 
established, all subsequent Control Points that are added 
will be linked to these settings. 

Adding Control Points 
Control Points are added by either importing or merging an 
existing .CTL (Control Point) file or by selecting Control 
Points > Add Point from the Main Menu and keying in new 
control point information manually.

Enter the Control Point (N:) name for the new point, add the 
Control Point information into the Field View, then select 

the key to Record the change.  

Example of Control Point Add screen: 

Editing Control Points 
Select the Control Point for editing, enter the correct (updated) values in the Field View, then 

select the key to Record the change. 

Removing Control Points
Removing existing Control Points is done by highlighting the 
point that requires removal in the Tree View, then select 
Control Points > Remove Point from the Main Menu. In the 
Confirm Delete dialog box, click the OK button to confirm the 
“Are you sure?” prompt.

The function key will also delete the record. 
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Point Processing 

Overview 
Point Processing is the numerical processing of raw survey data (horizontal circle readings, 
zenith circle readings, slope distances, height of instrument, height of target, level rod 
readings, taping distance observation, calibrations and point names) found in the .OBS file into 
coordinate information (.XYZ file) while tying to control (.CTL file). The Electronic Field Book 
Processing (EFBP) system does this by reducing the measured circle readings, distances to 
create angles and reduced distances, and also elevation changes into coordinates and/or 
elevations for all of the observed points. This processing will help identify any blunders and 
errors, providing vertical and horizontal least squares adjustment, and create data files that 
can be passed along to drafting/mapping/design software, while generating reports for review 
and analysis.

SDMS analysis is an alternative method that can be accessed within the EFB Desktop 

program. Refer to the SDMS Help file for operational documentation and tutorials. 
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ts in the current folder of the SDF project, thi 
herwise there will be a message indicating t 

will need to be chosen using the Select Proje

s file will 
hat none 
ct Folder

Note: When an OBS file exis 

automatically load, 
exists. An OBS file 
button command.

Quick Steps – Processing 

1. Select the .OBS file to be processed.

2. Choose Error Repetition method.

3. Verify default values, change if necessary. 

4. Save segment defaults. 

5. Select type of report to process.

6. Process data. 
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Quick Steps – Viewing / Assembling reports 

1. View Report (Processing Options tab) – View specific report selected 

2. Browse... - View existing reports individually by making selection from dialog box

3. Manuscript... - View Title page with Table of Contents and append reports together 
to create one comprehensive and paginated report file.
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Detailed Explanation 

Processing 

1. In the File Menu, select EFB Processor (EFBP) command to open the Segment Files 
Analysis dialog box. The program will automatically use the OBS file found in the current 
folder of the SDF file. 

• If more than one OBS file is located in the folder a list will be provided prompting 
the user to select the OBS file to process. 

• If no OBS file exists in the current folder a “No OBS File Found!” message box 
will display. Click the OK button. The Segment Files Analysis dialog box will open. 

2. When the OBS file is not in the SDF folder, click the button to access 
the applicable project folder for the OBS file requiring processing. 

• When there is only one OBS file located within the project folder the file will 
automatically be loaded. Upon the initial processing of an OBS file the system will also 
create the following three files: 

Default.con – When “Use Repetition” in the Error Estimates screen is Yes, the 
default setting changes will be stored in this default file.

Default.sd - When “Use Repetition” in the Error Estimates screen is No, the 
default setting changes will be stored in this default file.

Temp.job – contains Project name

• When there is more than one OBS file located within a project folder, a Select an OBS 
File dialog will appear and a selection will need to be made. The same rules apply for 
copying and creating files as stated above. 

3. Choose Error Repetition method from the top of the Error Estimates tab for the Use 
Repetition: field click Yes for Computed Repetitions and No for User Defined 
Repetitions. 

4. Default settings for the Tolerance Exceptions in Reports within the Processing Options 
tab. The Output Coordinate Precision within the Processing Options tab and Error 
Estimates within the Error Estimates tab are pulled from the EFB_Settings.xml file 
upon the initial processing of an OBS file. Change the value to any setting that 
requires modification. 
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5. Click the button from the Error Estimates tab to save default 
settings to the applicable defaults file. When modifications are made to the settings, the 
changes are stored in the default.con or default.sd files. (See Step 1 above for definitions of .con 
vs. .sd file types.)

6. Select the type of process desired from the following choices: 

• Preliminary Analysis (file extension .GEN) - process only to measurement reduction 
and network coordinate estimation. 

• Vertical Least Squares (file extension .1D) - process the above and through vertical 
least squares adjustment. 

• Horizontal Least Squares (file extension .2D) - process all of the above and 
through the horizontal least squares adjustment. 

• Final Coordinates (file extension .XYZ) - process all of the above, and resolve all side 
shots creating final output and all reports of processing. 

7. Click the button to process the data. 
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CTL.exe Utility 

1. Click the button to load the CTL utility. This utility allows 
editing of CTL files under program control.
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1. Browse...: To view existing reports individually,  
from the Processing Options tab, click the

button and check the desired reports

(s) to view and then click the button  
to display report(s). 

2. Manuscript... To display the Title Page with the 
Table of Contents, from the Processing Options  
tab, click the Manuscript button, check the  
applicable reports from the Segment Manuscript

Assembly dialog box and then click the  
button.

Viewing / Assembling Reports 

1. View Report: To view one of the four main reports, from the Processing Options tab,

click the button adjacent to the applicable report to be viewed. 
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4. Sample of Title Page with Table of Contents: This file may be edited utilizing the 
text file viewer commands. 

• To Assemble (append one after another) reports, check the applicable reports to be 
assembled from the Segment Manuscript Assembly dialog box and then click the 

button. This will create one summary report from all the reports selected. 

• To View pre-assembled reports without having to assemble, click the 

button. 

Note: From the displayed text screen, standard text editing commands may be used to 

save, print, format, etc.
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Appendix A 

Installing Windows Mobile Emulator 

Overview 

The following steps will enable the use of an Emulator version of the EFB Mobile unit. 

Files Required 

1. Program files for EFB Mobile or EFB Mobile .CE 

2. Windows Mobile 6.1.4 Professional Images (380.8MB) 

(http://www.microsoft.com/downloads/en/details.aspx?FamilyID=1a7a6b52-f89e-4354-
84ce-5d19c204498a#Instructions )

3. .Net Compact 3.5 Framework (EX: NETCTv35.cm.armv4i.cab) 

(http://www.microsoft.com/downloads/en/details.aspx?FamilyID=e3821449-3c6b-42f1-
9fd9-0041345b3385&displaylang=en)  

4. SQLCE3.5 for Windows Mobile (EX: sqlce.wce5.armv4i.cab) 

(http://www.microsoft.com/downloads/en/details.aspx?displaylang=en&FamilyID=5544  
c638-c532-48e3-871c-58b49c5d855c) 

Installation Steps 

1. Download and Install Windows Mobile 6.1.4 Professional Images. 

2. Download .Net Compact 3.5 Framework (NETCTv35.cm.armv4i.cab) and SQLCE3.5 
for Windows Mobile (sqlce.wce5.armv4i.cab)

3. Create a folder on the C:\ drive as a “share” for the emulator to retrieve 
files. Example path: C:\Users\Username\My Documents\EFB Share. 

4. Place the NETCTv35.cm.armv4i.cab file, the sqlce.wce5.armv4i.cab file and 
the EFB.Mobile folder into the newly created Share folder. 

The EFB.Mobile folder should be located in the Program Files\FDOT.EFB 3.1\Program 
folder. These may not be the exact file names as they differ from Mobile to 
Mobile.CE and there may be later versions on the Microsoft website. 

5. Launch Windows Mobile 6.1.4 Professional by navigating to All Programs from the 

Windows icon and selecting Windows Mobile 6 SDK > Standalone Emulator
Images > US English > WM 6.1.4 Professional.
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This

stored

6. Select the File menu and click Configure. 
step is necessary to identify (configure) the 
location of the Share folder, where files are 
for access from the Emulator.

boxbutton adjacent to the Shared folder:7. Select the General tab, then click the
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the

8. Navigate to the folder that was created in step 3 above. 

Example path: C:\Users\Username \My Documents\EFB Share.

9. Select the applicable folder, and then 
click OK button to save and exit.

This “share” folder will be referred to as 
the Storage Card in the Emulator.


